WELCOME
TO FIS BANNER

Navigation &
Document Query

FIS Banner WebSite Help

FIS Launch Page http://fis.ucsc.edu

FIS System Guide http://financial.ucsc.edu/Pages/Systems FISGuide.aspx
FIS Banner Manual http://finaff.ucsc.edu/banner

Purchasing http://purchasing.ucsc.edu

Workstation Setup http://fis.ucsc.edu/workconfig.html

FIS Training http://financial.ucsc.edu/Pages/TrainingFIS.aspx

FIS Banner Navigation & Document Query Workbook - Update 2/26/2008


http://fis.ucsc.edu/
http://financial.ucsc.edu/Pages/Systems_FISGuide.aspx
http://finaff.ucsc.edu/banner
http://purchasing.ucsc.edu/
http://fis.ucsc.edu/workconfig.html
http://financial.ucsc.edu/Pages/TrainingFIS.aspx

Class Outline - 1:00 to 4:30

Welcome

Ergonomics

Overview of FIS BANNER

Logging on / off

Accessing BANNER Forms

BANNER Form Functions and Navigation
*Exercises*

Queries using FOIDOCH (Document History Screen)
*Exercises*

*Proficiency exercise*

* A proficiency exercise is completed at the end of class. You will be entitled
to your logon when you pass the exercise. You must also have an account
with ITS and have submitted a BANNER Access Form before receiving your

logon.

How to Get a Logon: You must have a valid FIS account to access FIS Banner.

Information on required forms for staff, faculty and temporary staffing appointment FIS accounts

can be found here: http://financial.ucsc.edu/Pages/Systems FISGuide.aspx#qget

List of Forms:
1. Account Modification Form

2. Access to Information Statement
3. UCSC FIS Access Request Form

Subscribe to fis_user at http://finaff.ucsc.edu/fis/fisuser.htm

INQUIRY FORM Description

FOIDOCH Document History Form (Acquisition Transaction Forms)
FPIREQN Requisition Query Form

FPIPURR Purchase Order Query Form

FAIVNDH Vendor Detail / History Form

FPIOPOV Purchase Order by Vendor Form

FOAAINP Documents in Approval Form

FAIINVE Invoice/Credit Memo Query Form

FGIISUM Journal Voucher Summary Form

FGIBDST Organization Budget / Financial Status Form

FIS Banner Navigation & Document Query Workbook - Update 2/2008


http://financial.ucsc.edu/Pages/Systems_FISGuide.aspx#get
http://finaff.ucsc.edu/fis/fisuser.htm

FIS BANNER Navigation Workbook
Contents

CONTENTS .ot b e bbbt b e b e e b e bt ekt e b e ekt eb et ek e s b et ek e et et ebesbe e ebesbe e ebennes 11
FIS BANNER NAVIGATION: OVERVIEW. ...t 1
INTRODUCTION ...ttt sttt sttt st e te st st tesbe st e te s b et e be s b et e be st et e be st et e be st et ebenbeneaee 1
BANNER OVERVIEW .....ctiiuiiuteitestesie sttt ss skt she b e nee sk he b e e es e e e bk eh e e b e e st e st e nn e b e nbeab e et e e e enrennen 1
DEfiNItioN OF TEIMS ...c.viiiice et be e e be e beeab e e bt e sbe e st e enbeeteesteesteas 1
SYSLEM OVEIVIBW ...ttt bbbt bbbk bbb et et b ettt ettt 2
LOGGING ON 1.ttt bbb bbb bbbt R bRt b R bbbttt 3

FIS BANNER NAVIGATION: BASICS ..ottt 5
LESSON L.ttt sttt sttt et b e e e b e b et et e eb et e R e b e e e R e bt e R e eb et e Eeebe e et e ebe e ereeaeneere s 5
INTRODUCTION TO BANNER BASICS ...ttt e nne e 5
LESSON ODJECLIVES. .....vieeiictiieeiecte ettt b bbbt bbbt b bbb 5
OVBIVIBW ...ttt ettt e bt et e et e et e e be e e be e be e s te e st e sheesbeesbeebeeabeaaseebeeabeeabeenbeesbestbesbaesbeebeennesnnenans 5
EXEICISE 182 MEBIUS .....iieieieiieiieie sttt sttt ettt s et e e st e be st bt et e e neenee st e besbeabesbeaneereeneeneeneens 9
EXEICISE 12 DIFECE ACCESS -..uveutetertesieeteeteete e ettt sbe sttt et et e e b s bt e bt e b e et e se e e e nbesbesbesbe s bt er e e e e e ee 12

FIS BANNER NAVIGATION: FORM BASICS. ... 14
[ 1S © ]\ OSSR 14
INTRODUCTION TO BANNER FORM BASICS......c.oiiiiiiiiii st 14
LESSON ODJECLIVES. .....veeitiitiieeieet ettt bbbttt b ekt b ekt sb ettt s bttt abe e et e sbenrere s 14
OVBIVIBW ...ttt ettt ettt e b e e et e et e e tb e e te e e be e be e be e s be et besheesheesbeeabeeabeeabeahseabeebeenbeenbeanbesteesbaestens 14
FFOIMS OVEIVIBW. ...ttt sttt ettt e e bt e et e e beesbeesaesbeesbeesbeesbeeatesaneabeesaeenbeenbaens 14
BanNEr FOIM NAIMING «...coueeiieie ettt bbb bt e s e et e besbesbe e bt sbeebeeneab e e e eneeee 17
Document Level vs Commodity Level ACCOUNTING ......ccoiveiiiiiriieiieieseeie e e 18
FOAPAL COUES. ... .cuiiveieiiiteieieste sttt ste st te st e sttt sbe e e e st e e e teebe e et e ebe st et e abe e e teabe e eteabensetesbeseeteabenenrens 18
Exercise 2: Navigating Within BIOCKS ..........cccceiiiiiiiiiecicesc sttt 19
Self-test Review 2: Navigating @ FOIM .........ccoci i st 23

FIS BANNER NAVIGATION: QUERY ..ottt 25
LESSON 3.ttt ettt ettt h e e h et Ee bt E e R R bR bRt R bRt Ee bbbt be st ene 25
QUERYING A FORM....utiiiitiiiiee it sie ettt ettt et e et bt sba e et e e s ba e et bt e e ba e e b b e e saa e et b e e nbee e tbeenaeeenbaeennne et 25
LESSON OB JECTIVES. .. ettt ettt ettt bbbt bt s e b e b ekt sb e bt bt e bt e s e e b et sb et e bt e b e e n b e 25
OVEIVIBW ...ttt ettt sttt ettt bbbttt b e bbb e bbb s b et s bt s bt et e st et e et st bt st ann 25

L@ 0 1= oV o] 111 TR OPPTR 26
WITACAITS ...ttt sttt b et s bbbt et b et et e st e et st e e et b ne e 26

FING FOIMS Lottt e et b e bbb b bt eb e e e b e b s e et e ebe st et e sbe st et e sbeneereas 28

FINA VS QUETY FOIMS ...ttt sttt st st e aeer e et e s e e et et snenreaneene e e eneees 28
Exercise 3: Query using Find and SEarch FOIMS ..........ccceriiiiieiniise e 29
Self-test Review 3: QUEIYING & FOMM ...c..iiiiiiiiiieieeeeie ettt 32
TABLE BY FUNCTION ... 33

FIS Banner Navigation & Document Query Workbook - Update 2/2008 iii



FIS Banner Navigation: Overview

Introduction

Banner Overview

The Banner Financial Information System (FIS) is a financial data
management and reporting system designed to help you store, report,
and analyze daily business operations.

Definition of Terms

It is helpful, when traveling in Bannerland, to speak the language.
Here are some useful terms:

Form - Forms contain one or more pages or screens. Forms are
divided into blocks where all the information is entered. They contain
these additional helpful components: Menu Bar, Tool Bar, Title Bar,
Information (Block) Areas, and Auto Hint / Status Line. Functional
(Application) Forms are used for data entry and query, while query
forms are used only to query the system for information. The most
important parts of a form are the blocks, fields, and records.

Block - Blocks are the information areas on a form, the major
component out of which a Banner form is made. Groups of related
fields compose a block. Fields logically grouped together are called
records. Blocks may contain several records.

Key Block - The key block appears at the top of each form and
indicates what is required to bring data into the form, or what codes
are required to prepare the form for data entry.

Field (Item) - Fields are the areas in a window where you enter,
query, or change information and where existing information is
displayed. They are either enabled or disabled (grey) and either
enterable or display only.

Record - Fields that are related to each other form a record. For
example, there are multiple commodity records in a Purchase Order
form for the purchase of several types of goods.
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Query - Query is the process of searching for and obtaining data from
Banner. You query to find out what information belongs in any field
that draws data from a validation table. You can also use queries to
pull up documents or to determine the status of a specific document.

Dialog Box - Dialog boxes are designed to help you complete
functions. A dialog box may appear when you try to exit a form
without saving your changes. You must respond to a dialogue box
before you can do anything else.

System Overview

Banner is a user interface program operating between you, the
database, and the computer. It runs on a database management
system called Oracle. The foundation for Banner, Oracle is the
software that sorts, updates, adds, and deletes data.

Banner uses a graphical user interface (GUI) with a navigation
structure very similar to Microsoft Windows. We use a “client-server”
model, where the data lives on one system (called the “database
server”) and the forms live on another system (called the “forms
server”). This spreads the load between two powerful systems so
neither bogs down the other. If you need assistance setting up your
workstation for running Banner consult with your unit’s local
computing coordinator. If you do not have a computing coordinator
you may call the ITS Information Resource Center (ext. 9-4357) for
further assistance.

Oracle, the FIS database, stores information in tables that are made
up of columns and rows. Each column is a field and the column
heading is the field name, which is usually descriptive of the data
contained in that column. Each row is a record that contains the
information for each entry in the table.

For example, the information from an address book might be stored in
a table where each person is listed in a row. The pieces of information
related to a person are stored in fields called Name, Address, City,
State, ZIP, and Phone.
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Logging On

New users need to complete three forms:
¢ the UC Access to Information Statement,
#® the ITS New Account Application (w/supplement), and
® the FIS Access Request Form.

Links and information about these forms can be found here:
http://financial.ucsc.edu/Pages/Systems FISGuide.aspx#get. Submit the

completed forms to the ITS Information Resource Center (IRC). The
IRC will setup your basic user account. After this account is setup, the
IRC forwards the FIS Access Request Form to FIS Security. FIS’s
security analyst will monitor and fulfill the request. After completing
the request, the security analyst will notify you via email that your
password is available at the IRC.

To access Banner, you must log on to http://fis.ucsc.edu
# Log on using the Production (Slug) icon
# Remember to keep the “Stop Sign” back up page open while
you are working in Banner.

These accounts identify you and regulate what you have permission to
do on the computer system. Each account has a unique name referred
to as the username (or login ID). Remember: your logon is your
signature — keep it private. An individual who shares his/her ID is
responsible for any transactions, whether willful or accidental, entered
into the system. Refer to the FIS Manual for information on selecting
or changing passwords.
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FIS Banner Navigation: Basics

Lesson 1

Introduction to Banner Basics

Lesson Objectives

Upon completion of this section, you will be able to:

Log on and log out of a Banner session
Navigate using the system menu
Enter a form using the menu

Enter a form using direct access

Exit a form

In this lesson you will use the Main Menu (GUAGMNU) and Direct
Access.

Overview

This workbook provides information on some of the main features of
FIS Banner. Please see the FIS Manual for detailed information.

Menu Navigation

Banner allows multiple paths to the same location. You select the
method.

The main menu is the starting point for navigating through Banner. All
Banner forms run in a window - a framed area on your screen. All
forms are accessed and navigated using a mouse or keystrokes.

After you log in to Banner, the main menu appears with a familiar
Window's format.
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The banner Menu Form displays two frames after successfully logging into Banner. Think of
these as a table of contents to be used to access a submenu, form, or job.

The menu bar’s drop-down menus list common functions, including many that can be used
for navigation. The tool bar contains icons representing common functions used to
navigate within forms. The Title Bar displays the name of the database and the current

form.

When you enter the Main Menu, the Go field is the current active field. Enter the seven-
character Banner form code name and hit Enter to go directly to that form.

o
Eile Edn {iplior Block Mem Bacor § T Hilp

FEFIEETEIE ST d @IS RE ¢ & @K

Go To... | "] Welcame, PHEALUER Products: | =] 4o |

I My Banner My Links
= Bannuer
AFinanoe [*FINANCE]
2 General Ledger [FINGENLL]
ZiFinance Operations [FINOPER)
2l Stores inventory ["FINSTORES]
= Purchasing and Proouremant [*FINPLRCH]
2l Accounts Payable [*FINAP]
I Budget and Position Control ["FINBUDG]
L Fined Asset ["FINASSET]
2 Cost Accounting ["FINCOST]
Zl inwestment Management [FININVEST]
Zl Research Accounting [FFINRESEARCH]
21 Archive ["FIMARCH]
ZlGeneral ["GENERAL]

Banner Broadcast Messages
17-FEB-2008 Welcome 10 FIS Banngr 71 Any problems? Send e-mail to fis_probsiE@ucsc adu

Enter the object nami; Priass LIST for listng

Record: 1 [ | I | sogC=
FIS Banner opens with the Select a menu for the area on  The full text form
Finance Menu automatically Finance you want to work in name and the seven-
deployed. It will be and click on it. Items in this  character Banner form
highlighted in blue. menu appear below this title. name are displayed.

Click either name to
enter a form.
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To exit a menu item or a Banner session:
Click on the Exit Icon in the toolbar, enter [Cntl+Q],
or Right Click - Exit.

Messages

The FIS Banner Messaging System automatically communicates the status of
documents to users of the system.

- —== -loix

u“—_x

Products: E| Menu | Site Map | Help Center

When you log in to My Links

FIS Banner, if you

have any messages, a Change Banner Password
green check mark will

appear next to "Check ‘
Banner Messages" in ;
the "My Links" section Personal Link 1
of the General Menu.

Check Banner Messages  #

Personal Link 2
Personal Link 3

Personal Link 4

Personal Link &
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EFI'S Banner - FNXT: Open > GUAMESG

Ele €0t Lyl Bock fem Becord Quey Tools telw
(YD EEES 59 B0® & & ©w)

wR General Message GUAMESG 7.4 (FNXT) .-

After viewing your
message(s), type [shift
F6] Delete Record from
the record you wish to
delete. You must also
save before you exit for
the messages to be
completely deleted. Right-
click anywhere on the
window and select
"Save", key F10, click on
the Save toolbar icon &
or go Menu: File and
select "Save".
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Message:
Reference I
System:

Recipient:
Message:
Reference Ix
System:

Message:
Reference I
Systam:

Message:
Reference I
System:

e
I =

F_- [:!Flmnr.'a
Comglete = Pending

|

|

| [~
| - .I -
Commplete

Pirncliog

Hlel

Confichistial

Sandi

Connjulet Pameling

Huxlel

Conficletial

Sendi

Comgleis Pofaclim

Haled

Comfichadslial

igar |0 ihad will receie the message; press LIST for users.

Record: 11

| «05cs
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Exercise 1la: Menus

w In the following exercise, you will expand and collapse the
menu to enter and exit a form.

What you do

1. Enter Banner.

2. Expand the Purchasing and
Procurement System Menu in the
left pane by clicking on the folder or
the name.

3. Next expand the Request
Processing Menu.

Note the selected menu name
displays blue. The associated
menus and forms display below it.

Comments/Prompts

9 FIS Banner - BPRD

Help

[ [%) (%) 1 <

1My Banner
_lBanner
—dFinance [FFINANCE]
_IGeneral Ledger [*FINGENLL]
_IFinance Operations ['fFINOPER]
1 Stores Inventory [FFINSTORES]
_1Purchasing and Procurement [*FINPURCH]
__lAccounts Payahle [FINAP]
_1Budget and Position Control [*FINBUDG]
_IFixed Asset ["FINASSET]
1 Cost Accounting [FFINCOST]
I Investment Management [*FININVEST]
1 Research Accounting [FFINRESEARCH]
1 Archive [FFINARCH]
_1General [F'GENERAL]

Banner Broadcast Messages

17-FEB-2008 Welcome to FIS Banner 71 Any problems? Send e-mail to fis_probsg

Enter the ohject name; Press LIST for listing.

Record: 171 | ] o | «<0gC=
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4. Click on the Requisition Query
Form, FPIREQN, located in the right
pane.

You can click on the description, or
the Banner form name.

E9 FIS Banner - BPRD

File Edit ©ptions Block ltermn Record Query Toaols Help

[ Ehy I [%) [#) | <

78 General Menu © MU 7411 (BFRD) - ehrua
Go To... [*] ‘welcome, PHEAUER
\_1My Banner

\_IBanner

ZFinance [FFINANCE]
[ General Ledger [FFINGENLL]
[_IFinance Operations [*FINOPER]
[Z1 Stores Inventory [*FINSTORES]
[_1Purchasing and Procurement [*FINPURCH]
(L1 Accounts Payable [*FINAP]
[_1Budget and Position Control [*FINBUDG]
IFixed Asset ['FINASSET)
[ Cost Accounting FFINCOST]
[ Investment Management [*FININVEST]
[_1Research Accounting [*FINRESEARCH]
[Z1 Archive [FINARCH]

(1 General [*GENERAL]

Banner Broadcast Messages

17-FEB-2008 Welcome to FIS Banner 71 Any problems? Send e-mail to fis_probsg

Enter the object name; Fress LIST for listing.

Recard: 171 || | | <08C=

You are now in the form.

5. To exit the form, click the Exit

icon on the toolbar, Right Click - Exit,

or enter Exit [CNTL+Q].
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6. Click on the Purchasing and
Procurement System Menu to
collapse the menu.

4 FIS Banner - BPRD

File Edit ©ptions Block ltermn Record Query Toaols Help

(@ EEEEIEREL EYEEEI
B 411 (B

Go To... [*] ‘welcome, PHEAUER

\_1My Banner

\_1Banner

ZFinance [FFINANCE]
[ General Ledger [FFINGENLL]
[_IFinance Operations [*FINOPER]
[Z1 Stores Inventory [*FINSTORES]
[_1Purchasing and Procurement [*FINPURCH]
(L1 Accounts Payable [*FINAP]
[_1Budget and Position Control [*FINBUDG]
IFixed Asset ['FINASSET)
[ Cost Accounting FFINCOST]
[ Investment Management [*FININVEST]
[_1Research Accounting [*FINRESEARCH]
[Z1 Archive [FINARCH]

(1 General [*GENERAL]

Banner Broadcast Messages

17-FEB-2008 Welcome to FIS Banner 71 Any problems? Send e-mail to fis_probsg

Enter the object name; Fress LIST for listing.

Recard: 171 || | | <08C=
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Exercise 1b: The Go To... Box for Direct Access

In the following exercise, you will enter a form using the GO
Box.

What you do Comments/Prompts

EAr1s Banner - BPRD

Eile Edit Qptions EBlock ltem EBecord Query Tools Help

1. Type the form ([u] (EHEER =T [ By I [ |%s
nhame FPIREQN in "m General Menu GUAGMNU 7.4.1.1 (BPRD) - Wednesday February 27, 2008
the GO Box and

press Enter. Go To... | E| YWelcome, PHEAUER

You go directly into My Banner
the named form. Banner
‘JFinance [*FINANCE]

_1General Ledger [*FINGENLL]

2. To exit the

form, click the Exit

icon on the toolbar, Right Click - Exit,
or key [CNTL+Q] Exit.

You have entered a form by expanding the System Menu and
by entering a form name in Direct Access.

Congratulations!

You have completed Lesson 1 of the Navigation Workbook!
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FIS Banner Navigation: Form Basics

Lesson 2

Introduction to Banner Form Basics

Lesson Objectives

Upon completion of this section, you will be able to:

. Determine your location using the Title Block
. Understand the form basics
. Navigate through a Banner form

Overview

This workbook provides information on some of the main features of
FIS Banner. Please see the FIS Manual for detailed information.

Forms Overview

All Banner forms run in a window and contain the following
components:
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Menu Bar (dropdown)
Tool Bar
Form Title Bar

Key Block

Auto Hint/Status Line

15 Banner - BPRD: Open > FPIREQN

file Edit Options Block Mem Record Query Tools Help

=10l

Requisition: 0
Order Date: (08-NOY-2003 Transaction Date: 0B-NOV-2003 [lin Suspense
Delivery Date: 14-M0Y-2003 Comments: [CIDocument Text
Commodity Total: 420013 Accounting Total: 420013
2 Complete 2 Approved
Print Date: Cancel Date: Closed Date:  |19-NOY-2003
Activity Date: 0B-NOV-2003 User ID: rm
Cancel Reason:
Document Type: ’P—PROCUREMENT
[INSF Checking [ Deferred Editing
Requisition Copied From:
Origin: BAHNER
Reference Number:
Record: 111 | ] | <08C=>

The Menu Bar provides drop-down menus where you select specific functions. To access
an option on the menu bar, click on the desired pull-down menu name. Click on the desired

menu item.

FIS Banner Navigation & Document Query Workbook
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[BAFIS Banner - BPRD: Open > FRIREQN =101
Menu Bar (dropdoWn) Eile Edit Qptions Elnk flem Record Query Tools Help
Tool Bar EIE
Form Title Bar

(BPRD)

Requisition:
oOrder Date: 0B-NOW-2003 Transaction Date: 0B-NOY-2003 Cin Suspense

Delivery Date: 14-NOY-2003 Comments: [CDocument Text

‘Commaodity Total: 420013 Accounting Total: 420043

Key Block

Requestor: Fisher LM COA: . [uc santa cruz

Organization: 443745 [PESEarth SciRschFisher Email: afisher@ucse

Telephone: Extension: 55098 Fax Number: Extension:

Ship To: s

Street Line 1: et Applicable
Street Line 2:

Street Line 3:

Building: Flnor: |
City:

State or Province: Zip or Postal Code:

Nation:

Telephone: Extension:

Contact: ot Applicable

Attention To: poe

AutO Hint/Status Line Record: 111 | | | <o08C> | J

The Tool Bar is located under the Menu Bar and contains icons representing common
functions. The Tool Bar allows you to perform many of the common Banner functions by
clicking the desired button with the mouse instead of using the Menu Bar or keystrokes.

(BB AEERE 4% EE QS REIEIL @1 X

If you position your mouse over a Tool Bar Icon, you can see a description of its
Function.
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The Title Bar is "w@ Requisition Inguiry: RequestonDelivery FPIREQN 7.3.0.1 (BPRD) -1
located under the tool
bar at the top of each
form. It identifies the
form and displays the
following information:

FORM Description FORM Name Version of Banner (Database)

Forms are organized into blocks or areas of related information. Forms usually consist of
a Key Block, one or more Information Blocks, and a Completion Block. A solid line often
marks the top and bottom of each block. Information from the Key Block is repeated as
the first block of each page of the record. Within blocks are fields. Fields logically
grouped together are called records.

The Auto Hint / Status Line runs across the bottom of the screen. It provides brief online
help about the field where the cursor is located. This information may explain the purpose
of the field, what can be done next, or how to move to another window or form. Error
messages also appear here.

Banner Form Naming

Finance System

You can learn the Purchasing Module
ownership, type, and Inguiry Form

use of any form, such Form Code Name
as the requisition

form, FPAREQN, by (Requiition)
learning the meaning
of each character in —_

its name. '_: ; i REQN

All Banner forms have seven-letter code names which use the following
convention: 1234444,

1. The first letter refers to the system

2. The second letter is a code for the module

3. The third letter is a code for the form type

4. The last four letters are unique abbreviations of the form name
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Document Level vs Commodity Level Accounting

In Banner, Finance, Requisitions, Purchase Orders, Invoices, and Journal Vouchers are
called documents.

Document level accounting allows you to use one or more funding sources to pay for the
commodities on a document by a percentage (or other distribution) of the document total.
Document Level accounting is more commonly used than Commodity Level accounting.

Example:
1st Commodity (plus)
2nd Commodity (plus)
3rd Commodity ( = total charge)
paid by
1st FOAPAL (100%)
or
1st FOAPAL (75%) and 2nd FOAPAL (25%)
or
1st FOAPAL ($partial amount) and 2nd FOAPAL ($balance)

Commodity level accounting allows you to assign one or more FOAPALs to each specific
commodity. In this case, you would change the DOC Level Accounting field in your
document to “N” to activate commodity level accounting.

Commodity level accounting must be used when you order inventorial items. Commodity
level accounting would be used, for instance, to purchase inventorial equipment and
components for existing equipment on one document.

Example:
1st Commodity paid by 1st FOAPAL (100%o)
2nd Commodity paid by 2nd FOAPAL (100%b)
3rd Commodity paid by 2nd FOAPAL (50%) and by 3rd FOAPAL (50%)

FOAPAL Codes

UCSC BANNER FIS CHART OF ACCOUNTS

The combination of EANNER: Famd Organization Account Program Activity Location
Fund, Organization,
Account and Program F O A P A L
codes are required on
expenditure, revenue,
and transfer
transactions. Fund: uniquely identifies all sources of funding

Organization: unit of budgetary responsibility; eg College office

Account: Expenditures, Revenues, Transfers, Assets, Liabilities, Fund Bal.
Program: function categories; eg Instruction, Research, Student Serv.
Activity user defined; for cost center accounting
Liocation: building; reserved for future use

EHAMFPLE: 68990 620300 001010 ] QMTIRDC

FIS Banner Navigation & Document Query Workbook Page 18



Exercise 2: Navigating within Blocks

In the following exercise, you will navigate through the Banner
blocks using the Requisition Form (FPIREQN).

What you do Comments/Prompts

EAr1s Banner - BPRD

File Edit OQptions Block Itermn Becord Query Tools Help

1. Enter Banner, then ( @l (EEER TS E X ERy [
enter the fc_)rm name ’E_E General Meny GUAGMRKU 7411 (EFPRD) - Wednesday February 27, 2008
FPIREQN in the GO

To... Box Go To... |FRIREGN (*] ‘Welcome, PHEAUER

My Banner
Banner

EA 15 Banner - UTRN: Open = FPIREQN

2. Enter "RO006196™ File Edit Options Block ltern Record Guery Tools Help
in the REQUISITION

field. (BOE REAEBR 4% REE

3. Enter Next Block or
select Menu: Options:
Document Information to Requisition:
display (populate) the
first block of the form.
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What you do

Comments/Prompts

4. Select
} . . File Edit Options Block |tern Record Query Tools Help
Menu: Options: (YD AOEE %y BEE @G & BE ¢ 30 1@ X
Document Text to 22 Requls 0.1 (UTRN)
enter FOAPOXT and Recqistion:
view the Document order Date: 07-JAN-1997 Transaction Date: 07-Jan-1997 Clin Suspense
- Delivery Date: 07-FEB-1997 Comments: [ Document Text

teXt' It IS also Ca”ed Commodity Total: ’m Accounting Total: ,W
Header Text.

[¥ Complete W Approved

. . Print Date: ’7 Cancel Date: ’7 Closed Date: ’7
TO exit the fOI’m, CIle Activity Date: W User ID: [opssTRANM
the Exit icon on the
toolbar, Right Click - Conce s -
Exit1 or key Document Type: [ PrROCUREMENT
- [CINSF Checking [JDeferred Editing

[ContrOI + Q] eXIt' Requisition Copied From:

Origin: [panmer:

Reference Number: |
Now we'll go through
the blocks. Review
the information on
each page as it
displays.
5. Select
Menu: Options:
Requestor/ Delivery
Information or Next
Block.
6. Select
Menu: Options:
Vendor Information
or Next Block.
7. Finally select
Menu: Options:
Commodity/
Accounting
Information or Next
Block.
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What you do Comments/Prompts

At the Commodity/ Accounting information block, the
Menu: Options: listing displays additional links.

Use the top right arrows to scroll through options currently
not displayed.

8. Let's select Menu: Options: Commodity Supplemental
Information to view the assigned buyer. Remember that in
addition to the Close button, the Exit icon and keystroke are
available.

9. Menu: Options: Review Commodity Information displays
a commodity list. Remember to Exit when you enter this
form.

10. Menu: Options: Item Text is also called Commodity Text.
It displays text for the selected commodity. Exit the text
form to return to FPIREQN.
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What you do

Comments/Prompts

Now let's look at the
commodities /

Eile Edit Options Block |tem Record Query Tools Help

B3 F15 Banner - UTRN: Open > FPIREQN

accounting screen. The

HEEE PT REE S

Com mod ity bIOCk and ion Inguiry: ting FRIR 1 {(UTR
i Requisition: ROODG196
th e aCCO u ntl n g b I OCk Order Date: O7-JAN-1997 Transaction Date: (O7-JAN-1997 Clin Suspense
display on one screen. DoeryDate: e ¥ Documant Taxt
Each block may contain e
several records.
um Tax Group Quantity Unit Price
ttem ’71 of ’73 ’? | X 3,500,0000 = Extended: 3,500.00
Discount:
Commodity Description Additional:
Computer CPU hodel MES104 Cleommutiny Text Tax:
Whe n com mod Ity Ievel Computer CPL Modls! MES334 [“Ciosed Commodity Line Total: 3,500.00
ting is used, the o
aCCO u n y Clsuspense
FOAPAL information for
the selected FoapAL [ 1 of [ 2 [ Suspense TINSF Override usD
(hlghllghted) Comm0d|ty [INSF Suspense E:::::: 3,150.00
d|Sp| ays below_ As you COA Year Index Fund Orgn Acct Prag Acty Locn Proj Additional:
¢ 7 fesmn [ozmen foorem a0 Tax:
arrow throu g h the 7 | [eaz00 aozaa0 [oorozn fao FOAPAL Line Total: 315000
Commodity records’ the O] Commodity Accounting Total: 350000
related cost and FOAPAL
|nf0rmat|on d|sp|ays Press NEXT BLOCK to navigate to Accaunting block | J
Recard: 113 [ .| | | =0gC=
11. To exit the form,
click the exit icon on the
toolbar, Right Click - Exit,
or key [CNTL+Q] Exit.
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Self-test Review 2: Navigating a Form

&

self-test
L

1. Go into the form FPIPURR. Enter "PO005442" in the PURCHASE
ORDER field. Practice going from block to block using
[Ctrl+PgDn] or one of the other methods. Be sure to enter the
text forms (both Header and Commodity). Remember when you
are done viewing the text to Exit.

2. Go into the form FPIRCVD. Enter "Y0O003265" in the RECEIVER
DOCUMENT CODE field. Practice moving within the form.

3. Select other inquiry forms that you use and practice navigation.

You have navigated through blocks using keystrokes, icons, and drop-down menus.
You have navigated through records using the keyboard.
You have located, entered, and exited both document and item text forms.
Congratulations!

You have completed Lesson 2 of the Navigations Workbook!
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FIS Banner Navigation: Query

Lesson 3

Lesson Objectives
Upon completion of this section, you will be able to:
L Use search and find queries to locate and review information

In this lesson you will use the Document History Form (FOIDOCH).

Overview

This workbook provides information on some of the main features of
FIS Banner. Please see the FIS Manual for detailed information.

You can query Banner forms when you don’t know the appropriate
information to enter in a field or when seeking specific information
already entered in the database. Query includes inquiry forms and
most application forms. The two different types of Query screens are
Search Form and Find Form.

Banner displays two different query indicators:
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FIS Banner - UTRN: Open > FOIDOCH =10 5[

The Document File Edit Opfions Block Item Record Query Tools Help
B G B EE El = @ X

(AYE AAEBE %Y @

Type field IS ,;{.:EE‘I:‘I:L”'I'IE‘V'ITHi‘E-tDI"." FOIDOCH 7.2L0 (UTRM) [0~
searchable by ]
double- Ducu::nt-Ti?e: ’;E‘Reuu\smun _ - —_— Document Code: ]IiElsm
C“Cking in the quisition |7us: i |7us: urchase Order |7us: Issues rus:
field, keying 0| [ U U]
F9, or clicking I Sy ) I N Ry WY I
on the Search 0| 0[] [ | 0| [ O]
icon !il. Invoi Stats Check Stat Ret Stat Recen Stat

0 & 0 & 0 O
The Document — F | — F | — F _ — F |
Code field is
Searchable by Asset Tag S||3us: Asset Adjustment SiFus:
keying F9, or 1 [ C 1 [
clicking on the [ ] Ok L U
Search icon — F ' — F '
!3 1 0% 1 [OF

Enter document type or choose LIST to view valid options |
Record: 141 [ . | Listorvaiu... |

e
o
@
o

W

Query Forms

Several forms open in query mode. These forms display the message:
ENTER QUERY in the status line. A form opens in query mode when
the number of records to be retrieved is so large a significant display
delay may occur. Other times you will request a List of Values (LOV)
to being a query.

Query steps include:
® List of Values [F9]: Enters the Query or Find form.

* Enter Query [F7]: Enters query mode allowing use of
wildcards [26__ ] to limit the search.

# Execute Query [F8]: Displays all matching records.

¢ Exit with Value [Shift+F3]: Selects the value and brings the
record back to your working form.

Wildcards

Wildcards stand for any alpha-numeric character. They are “_”
representing only one character and “%” representing any number of
characters. Wildcards can be used many times in one search. The
Query search is always case sensitive, meaning that upper and lower

case must match exactly.

FIS Banner Navigation & Document Query Workbook Page 26



To get these results Enter this criteria

All entries that contain ma % ma%
All entries that begin with ma ma%o
All entries that have ma as the final two characters % ma
All entries that have m as the second character Mm%
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Find Forms

You may,
without
clicking
anywhere,
type the
letter you
think begins
the correct
answer.
Banner
automatically
goes to the
answers that
start with
the letter.

Find|%

Document Type Document Description LastAc =~
Adjustments to Inventory ’
AGH Agreements 10-JAR
BAS Basis Code 01-JL
EF M Grant Billing Format 07 -hlasy
BID Fequest for Bid 01 -
ErMD Bonds 21-JAM
ERG Budget Reguest 17-JUIL
C|CK Check Cancellation 24-00° 7

o | Y i i I 4

[Qanceljl

To exit with value, highlight the selected value, then type [enter],
double-click, or click the OK button.

Find vs Query Forms

Find Form

values automatically display
opens in query mode

starts with a wildcard (%b6)
not case sensitive

Query Form

# fields blank if it opens in query mode

case sensitive

FIS Banner Navigation & Document Query Workbook
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Exercise 3: Query using Find and Search Forms

What you do

In the following exercise, you will perform both a find and a
search query using the form FOIDOCH.

Comments/Prompts

1. Enter Banner,
then enter the form
name FOIDOCH in
the GO Box.

EAr1s Banner - BPRD

File Edit OQptions EBlock Iterm Eecord Query Tools Help

([L.] B RAEEE %% E X[ Ehy | [

-

eral Menu GUAGMRML 7.4.1.1 (EPRD) - Wednesday February 27, 2008

Go To... |FF‘IREQN

[*] ‘Welcome, PHEAUER

My Banner
Banner

2. With your cursor in
the DOCUMENT
TYPE: field, double-
clicking in the field,
key F9, or click on

the Search icon EI

EA 15 Banner - UTRN: Dpen > FOIDOCH

File Edit Options Block Item EBecord Query Taals Help

(B0 E RARE 499 ZEE Q& XK

sm Document History FOIDOGH 7.3 L0 (UTRM)

| Eﬁequisitiun

Bid

11

1|

i}
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3. Before doing
anything else in the
Find Form, enter
"re" then double-
click your selection or
press [Enter].

Find|re%

Document Type

1

Document Description

Reguisition

K lQancel),l

4. In DOCUMENT
COD field, enter [F9]
or click on the Search

icon IEI

=10 %]

Last Activi

07 -JiIM-1

Document Code:

iase Order

Status

[ [ .

FIS Banner Navigation & Document Query Workbook
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BAF1S Banner - UTRN: Open > FOIDOCH - FPIRQST

5_ Enter Query [F7] File Edit Options Block [tem Record Guery Tools Help
using ""Sue Miller" (@AB HEBE 5D BEE I EKE <

ma Requisition Validation FPIRQST 7.0 (UTRN)

as the REQUESTOR
and " % 1 99 7 " as the Request Number Requestor Name Request Date Request Type Deliver by Date
REQUEST DATE \ Stillere 19975 e r

. Organization Completed Approved
Execute Query [F8] [ | [ r
an d h |g h | | g ht th e Vendor Origin Reference Number
record for Vendor: | | [E—]
Apple Computer Inc.
(ROOOG 1 96) . Exit Re‘uuest Number Requestor Name ‘ Request Date Requ|eit Type  Deliver by Date
Wlth_ Val ue Organization Completed Approved
[Shift+F3] to return i | M M
to FOIDOCH with the Vendor Origin Reference Number
highlighted record. | | I

EAr1s Banner - UTRN: Dpen > FOIDOCH

6. Enter Next Block
to display (populate) File Edit Options Block ltern Record GQuery Tools Help

FOIDOCH. (BB RBEEE 20 BEE & &I |

7. To view a specific
document, highlight

the document and
enter [F3] Duplicate Document Type: RE&! [T Reguisition
Field or select Requisition Status Bid Status

Menu: Options:
(Formname)
Information to

"

. ; [
display the specific li |_
[

L

document. We’'re
selecting the
Requisition.

T

Please refer to
Exercise 2 for
information on how
to navigate through a
form.

8. To exit the form,
click the Exit icon, Right
Click - Exit, or key
[CNTL+Q] Exit.
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Self-test Review 3: Querying a Form

&

self-test
L

1. Enter FOIDOCH. Repeat Steps 1-8 looking up the following
information: REQUESTOR - Manager Navigation #1, VENDOR
NAME - Office Depot Inc.

When you have completed your review in FOIDOCH, click
"Rollback™.

2. Search on your name, birthday or some random information just
for fun. Make a selection and look at the forms. Use Steps 1-8 for
assistance.

You have used both a Find and a Query Form.
You have completed Lesson 3 of the Navigations Workbook.

Congratulations...this is the final lesson!

Please continue to practice in FIS Usertrain until you are comfortable with Banner.
To logon to FIS User Train:

# Go to http://fis.ucsc.edu

# Click on the FIS User Train red apple logo,
# Username: train## (e.g. train23)

® Password: utrn # # (e.g. utrn23)
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http://fis.ucsc.edu/

Banner Actions:

Keystroke, Menu, Right-Click or Toolbar

Action: FORM | Keystroke | Menu Bar Right Click | 1°° Esplanation
FollbaclyClear shift F7 File = Follbaclk FaghtChick- _|Beturns cursor to key
Form Follback £ blocletop of form
Form to Form F5 File = Direct Lets you navigate to
Direct Access (donot use  |Access any forrm without
with leawing the form you
FAAIVCD or are i
FEAIVEL)
Action: BLOCK  |Keysiroke |Menu Bar Right Chick Fg:;l Explanation
Mezxt Block control Block = MNext Eﬁl Ilowes cursor to next
pagedown witidow or block
Presious Block control page |Block = Previous %_ Iloves cursor to
up previous hlock
Action: FIELD | Keystroke | Menu Bar Right Click ];;1 Explanation
Clear Field/Ttem control u Field » Clear Clears current field
Duplicate F3 Field » Duplicate Creates duplicate of
Field/Ttem previous record
Mezxt Field/Ttemn tah Field = Mext Ilowes cursor to next
field
Presious Field/Item | shift tab Field = Previous Ilowes cursor to
previous field
Action: RECORD |Keystroke | Menu Bar Right Click ];;1 Explanation
Clear Fecord shift F4 Fecord = Clear Clears record
Duplicate Fecord  |F4 Record = Duplicate Creates duplicate of
previous record
Inzert Fecord Fa Fecord » Insert e Inzerts a new hlank
record
Mext Record downarrow | Fecord = Mext shows the next record
Mext Set of control = or | Query = Fetch shows the nest set of
Fecords cottrol Mext Set records from a lst that
shift = gcrolls beyond the
SCreetl
Prewious Fecord  |uparrow Fecord » Previous @ shows previous record
Femovwe Record shift Fé Fecord = Femove & Femoves (deletes)
record
acroll Down downarrow  |Record = Scroll acrolls down
Down
acroll Up uparrow Record = Soroll Up scrolls up

FIS Banner Navigation & Document Query Workbook

Page 33



Banner Actions: Keystroke, Menu, Right-Click or Toolbar

Action: QUERY  |Keysiroke |Menu Ear Right Click ]];:]r'ﬂ Explanation
Cancel Query control g uery = Cancel @ Cancels a query
Count Query Hits  |shift F2 Query > Count Hits Counts number of
records
Enter Query F7 Cuery = Enter ey |Beging a query (or
== | zearch)
Execute Query F& Juery = Execute =y |Executes a query (or
1 search)
Fait with shift F3 File » Select Fits a walidation tahle
Walue/Select with datafralue
Fxit/Cancelf control g File » Exit X Fxitz a form, ends a
Fit without Value query
List of WValues Fa Help » List Drisplays the walidation
(Lo tahle for a particular
field
Wildcards Yo shift 7 Wildcard value
Action: EDIT | Keystroke | Menu Bar Right Click ];;1 ol
Beginning of Line  |home Ilowes cursor to
beginning of field line
Drelete Baclowards  |hackspace Dreletes characters to
the left of the cursor
Delete Character delete Deeletes characters to
the right of the cursor
Enter enter or [ Some keyhoards have
return a return ey rather than
an enter key)
Fnd of Line end Ilowes cursor to end of
field line
Eziti/Canicel! ) . E=its a fortmn, ends a
Fit without Value LA LI X query
Fefresh cottrol p File » Refresh Refreshes the
cotnpter screen
sawe/C ot Fl0 File » Save maves [or comtmnits)
= | data
acroll Left leftarrow acrolls left
acroll Fight rightarrow acrolls right
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Banner Actions:

Keystroke, Menu, Right-Click or Toolbar

Bomzes

Action: MENU | Keystroke |Menu Bar Right Click ];;1 Explanation
Direct Access F5 File = Direct Dizplays "Go to..." field
Arcess above existing form,
pertnits direct form
entry instead of hawing
to exmt from current
form
Ezzit Ivlenn Bar ESC E=its the mmenn bar,
when using keystroles
to nawigate the menu
bar
Ifler Bar PC:alt (plus Opens a menn on the
first letter of et har. 1Tze up and
ey dowrn arrow keys to
navigate within the
Mac: mem; left and right
comrnand arrow keys to move to
(plus first ather memus. Type
letter of [enter] to select a
menu) cotrtnatd, or [esc] to
ezt meny bar.
Action: HELP | Keystroke |Menu Bar Right Click ];;1 Explanation
Crnarmic Help Help > Drynatmic Prowvides help and
Help Query explanations at the
field, hlock and screen
lewrels
Action: OTHER | Keystroke | Menu Bar Right Click ];;1 Explanation
Print shift F& File > Print I Iflales a screen print of
CUrtent screen
Select Pull-Diown |arrows enter Selects itern from pull-
List down list
select Fadio arrows selects item from radio
Groups group
show Function control F1 Help » Show Keys shows a list of
Keys availahle keystrokes
Toggle Check space har Toggles check hox

oti'off
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